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PRESIDENT' S REPORT

Wayne Al

QCIPUG is not dead nor dying!

However, organizations are like people.
There is a birth, growing up, learning,
maturing and, eventually, death. OCIPUG
has been through several of these stages
already. Our birth was a very small group
of active computer members who forimed
the Orange Coast IBM PC User Group. We
have experienced growth along with the
growth of personal computers.

We were unique among user groups in that
we had a facility dedicated to our exclusive
use. Most other groups meet either on a
single day or they share several scattered
places with other organizations.

Why did we move? I received a message
from Ed Leckliter via the Internet about our
vacating the Resource Center. Ed is out of
the country on business but still in touch, as
many of us are, via ¢-mail and was very
concemned. Ed’s points are well taken and
I believe will be echoed by our members.
My response to Ed will give you more
information on the necessity of our recent
changes.

“Ed - Thank you for your interest and
feedback on our vacating the Resource
Center. As you said, you do not have any of
the facts. Perhaps a few are in order.
OCIPUG has less than 400 members.
Renewals have declined to less than 50%
each month. SIG attendance has dropped
to average less than 5 people attending each
SIG. We have non-members conducting
SIGs who feel they do not need to pay dues.
Of over 400 e-mails sent to members
requesting donations for the auction and
assistance in moving the Resource Center,
we received less than a dozen responses.
We have tried passing the hat at general
meetings with limited success. We have
tried the options you suggested in your note
without success.”

Furthermore, personal computers are no
longer expensive, complicated machines
affordable only by businesses and under-
stood only by geeks with pocket protectors.
Today's PCs are appliances. People’s
expectations are that the machine will be no
more complicated than operating their TV
remote control.

We are evaluating what changes are needed
to restructure owr Group to meet our
members needs. We have not lightly given
up the Resource Center nor made light of
any of the changes you will see. The Board,
your elected representatives, has consid-
ered and will continue to consider what is
best for our Group. If you have ideas, and
are willing to work to implement them,
please step forward, come to the 30
November meeting of the Executive Board,
or call any member of the Board with your
desires and suggestions.

We have had some pretty significant
changes occur last month. We lefi the
Resource Center on 29 November and
moved our BBS. Thanks to Michael
Springer and Preston Hill, our BBS is up
and rumning, temporarily at Preston’s
house. The new number is 714-892-1291,
Calls to 714-751-3242 will be forwarded to
the new number but please use the new
number to reduce the size of our telephone
bill,

I thank all of you who helped move our
equipment and furniture from the Resource
Center. | have recently returned from
several weeks out of town, without any on-
line access, and could not help with the
move. Please take a moment to read the
Minutes of the Executive Board meetings
and recognize the accomplishments of our
volunteers.

Speaking of volunteers, ! thank those who
worked on our auction: Richard Black,
Tony Dopazo, John Gallie, Preston Hill,
Chris Lloyd, Ed Miller, Rob and Tina
Nelissen, and Bob Peringer.

What next? There will be more changes as
we move to accommodate the needs of our
members and the changing times. Bill
Splitter is contacting our SIG leaders to
establish meeting places for SIGs. When
OCIPUG started, SIGs were held in many
different places in the interest of economy
and efficiency. We are looking into
changing our General Meeting place that
may better meet our needs.

We are still pursuing a host for our web
page and a different Internet e-mail
provider. We will also be revising our dues
now the expense of the Resource Center is
no longer a factor, Have you noticed the
change in the format of Readme.Doc? This
was done to reduce printing costs. What do
you think?

How are all these changes going to le
accomplished? That will depend on YOU!
OCIPUG has relied on the volunteer work
of our members for all the benefits you
enjoy. Your elected Board of Directors has
spent many hours these last few months
making some hard decisions on our course,
We have had several members step forward
to help us complete some key tasks; do you
know who they are and what they have
done? Why not? Has OCIPUG has grown
too large for members to know and help
each other with the mysteries of personal
computers?

We are at a point where we need some
members to step up and help us. Can you
make some phone calls, send some e-mail,
filf in the blanks in a form letter and mail it?
How about reading an article for
Readme.ldoc to check spelling and
grammar? Do you have experience in
organizing and conducting meetings? We
need a replacement for Chris Lioyd, our
Program Chairman. Chris is available to
help in the position but has resigned his
position because of the demands of his new
job. Wealsoneed someone to replace Norm
Bergman as managing editor of
Readme.Doc. A managing editor doesn’t
necessarily need to write anything for the
publication. The position is that of an
overseer who decides what content is in the
publication, where it goes, and assures that
material is received on time.

I have heard several people question
OCIPUG’s continuation. There have also
been those who thought space flight was
folly, one Meg of RAM was enough, and no
one could ever fill a 5MB hard drive.
Where do you fit in? If you support
OCIPUG, we can reciprocate and help you.
We do not need to be rocket scientists to
enjoy the technology intoday’s PCs. Wedo
need to learn from each other about these
beasts. I'm sure you have spent a few hours
at one time or another “fixing” your
machine to bend it to your will. Can you
share your success with us? Tell another
member at a meeting. Post a note on the
BBS about your success. Iknow the time I
spent with one of our members on the phone
helping him this weekend was good for him
and me. He is also now a lot less frustrated,
and more confident with his machine. 1 feel
good that 1 did know enough to help
someone solve a problem. Besides that, |
always learn by helping. Hey! Isn’tthata
good reason to be in a user group?



January Program
January 30,1999 9:00AM

Random Access 3:30
President’s Message 9:00
ENFISH 9:15
Announcements 10:15
Break 10:30
MEL MELLINI 10:45
Drawing 11:45
Adjournment 12 noon
ENFISH TRACKER PRO

Don't just file it, don’t just find it
Track it, automatically, with
Enfish Tracker Pro

- Overloaded with information? Do you ever
wish you had an automated assistant who
could organize and file everything on your
computer, so you could always find exactly
what you need, when you need it? Life is
- easier when you organize it with Enfish
Tracker Pro, a new softiware for Windows
.95, 98 and NT PCs. The name Enfish is
an acronym that stands for Enter, Find and
.-Share — describing the ways in which
;.'pedp'le interact with information.

;_;-Trackers. A quantum Ieap beyend
- ordinary folders .

" Enfish Tracker Pro is the world’s first
information Tracker™ — a totally new
paradlgm for dealing w1th information.
Instead of manually dragging icons into file

_folders, or manually searching for
information, you just set up a Tracker in

“advance using the Enfish Tracker Wizard.

“Simply - specify. words, phrases and
instructions that tell the Tracker what
you’ré looking for. The Tracker constantly
“witches” for new information that

* matches. your personal interests in the

documents, e-mail, newsletters, Intranet

-and Internet Web sites you choose to

-monitor. Finding something in seconds

- “with'a Tracker is as simple as (and even -

N morepowerﬁxl than) using a search engine.

Trackers are “ﬁfhlai" -Athey Jjust point to
n _the injbrmanon, they never physically move

- document no mater if it’s physically stored
on yourhard drive — or it’s halfway around
. the. world on a web site. A single Tracker
“can “contain™ e-mail messages, graphic
" files, spreadsheets, web pages, electronic

hus,. Trackers can “hold” almost any

newsletters, personal database (PIM)
records and documents that are stored on
the company Intranet or LAN, Even ifyou
delete a Tracker, the information is still
there.

What makes this possible is Enfish
Technology's patented DEX™ technology
that automatically cross-references, indexes
and links related information from many
sources simultaneously.

System Requirements

Enfish Tracker Pro requires an Intel
Pentium 166 or higher compatible PC
running Windows 95, 98 or NT 4.0; 16 MB
RAM (32 recommended, 64 optimal), a
hard drive with 50 MB free disk space, 256
colors VGA or higher display card/monitor.

Intemet connectivity is recommended.

COMPUTER-AIDED

INVESTING

Our own Mel Mellini will present “HOW
THE STOCK MARKET WORKS”. He
will demonstrate the new VectorVest
ProGraphics investment software with it’s
powerfully new add-on, “ProTrader’s” and
it’s many new features and meney making
capabilities in today’s volatile market.

0
OCIPUG General Meeting
~ Report
31 October 1998
Richard Black

The October 31, 1998 General Meeting.

began with Michae! Springer fielding
questions from the members who were
having problems.

The meeting was officially opened by Rob
Nelissen, Secretary, as President Wayne Ali
was out of town on business. Past President
Preston Hill then welcomed the members
and told them that OCIPUG has moved out
of the Resource Center (aka SIG space) as
of 26 October. OCIPUG could not afford

" the expense of the Center due to severely

declining memberships, and the low
turiiouts at most SIG meetings. He also
mentioned that the club is looking for a
more economical site for the General
Meetings because the college will raise the

“ rentin 1999, As'the last few meetings have

had a relatively low attendance, a place to
seat 100-150 attendees would be adequate.

Everyone was urged to seek potential
meeting places for the General Meeting and
81Gs.

Herb Huey fellowed with a reprise of
previous presentations, included elsewhere
in this publication. In a humorous way, he
reminded us of the many potential follies
of using computers along with some gems
of computer insanity.

The annual auction and our membership
dues are the two biggest sources of income
for OCIPUG. The auction is also a chance
for members to get great deals on software
and hardware. Which is why | am
perplexed at the relatively few number of
members who came. Although there were
only 60 to 65 members present, including
the auction staff, OCIPUG managed to raise
about $2,600. If you weren’t there, you
missed out. For example, many of us paid
a special User Group price of about $50 for
Micro 2000 Centurion board at the
September meeting. Some lucky members
paid just over $30 at the auction. The
starting bids were set at only one-third of
estimated street prices. Now that is a deal!
Some members even bid higher than the
street price knowing that they would be
buying the products anyway, plus sales tax,
and a few dollars more aided OCIPUG.
Thank you to all who purchased at the
auction. You saved money and OCIPUG
made some money to pay its bills. Can
therebe a better combination than that? 1
don’t think so.

Don't forget, at the November meeting, to
thank Karla Heider, Preston Hill, Herb
Huey, Charles Schreiber and the other
members who put this issue together. We
no longer have a Newsletter Editor. No
one has come forth to offer his/her time to
edit the newsletter. That means there could
be no more newsletters for a while.
Bummer. One of the reasons ! joined
OCIPUG was because of the newsletter. |
am optimistic. I renewed my membership
at the October meeting, Anyone out there
want to practice writing or editing
newsletters? 1t can be a great way to learn.
It may even look good on your resume,

See you at the November General Meeting.
Note that the meeting is on 21 November.
Please advise everyone you know of this
date as the SIG Guide calendar had the
wrong date.



Herb’s Hangout
Herb Huey

A Thief in the Night {A reprise)
Technology is like the thieving magpie that
steals a shiny object and leaves something of
lessor value behind. Computer users are
quick to embrace the next shiny new
technology not realizing that we will lose
something in retun. An example is the
tribal storyteller who recites long epics at
the fire. Today with printed material so
readily available such a storyteller would be
branded as a lunatic.

Digital watches have made our kids less
proficient at telling time. XKids tend to
report time as 12:45 rather than a quarter of
one. We face a loss of fine penmanship with
the progression of quill pens, fountain,
ballpoint and felt tip pens, typewriters and
finally the word processor and printer. Kids
can’t do simple math in their head now that
they have calculators. My 17-year-old
daughter still can’t figure out how much 10
dolls at $6.95 will cost and add 8% tax to it.
However, she can quickly tell me how much
change I will get back from a $100 bill —
nothing!

Technology has its place. The microwave
reheats our food quickly but microwaved
chicken is still for the desperately hungry.
VCRs & camcorders capture important
events in our lives while many of us can’t
live without our pagers and cellular phones.
Computers enhance our lives via word
processors, spreadsheets, e-mail, databases
and contact lists, etc. After all ifit’s done by
a computer then it must be right!

Technology gives you convenience but
seldom any extra time so don’t be so quick to
embrace new technology until it is proven.
Technology gives you something and takes
something away, just like the thieving
magpie, it takes our innocence. Once you
embrace new technology you can’t turn
back the clock.

The Computer Will Never Be the Servant
of Mankind (Another reprise)

We are slaves to the computer. Computers
punish our frail human bodies. Repetitive
stress. injuries (RSI) such as carpal tunnel
syndrome are widespread. Lesser injuries
include headaches, eyestrain, and soreness
in our backs and shoulders. We worry about

electromagnetic emissions from our moni-
tors. There may be a cumulative effect,
especially on pregnant women, from very
low and extremely low frequencies (VLF/
ELF).

New PBX switching software automati-
cally dials phone numbers cold and
switches to the next available telemarketer.
Name one employer who is not interested in
software that can double or triple worker
productivity, OQur pagers and cellular
phones help us to never miss an important
call but we are trapped in our 24-hour
virtual offices. There is software that
allows your boss to monitor your work or
listen in your conversations. Video
cameras monitor workers both inside and
outside the facility.

Laptops and modems can liberate office
workers and keep them productive in the
field or after hours but when has the
computer actually saved you time? Has
your boss actually given you time off
because the computer saved you time? Has
your workload decreased? What the
computer does is enhance your productiv-
ity. The downside is that increased
productivity means more work for you.
Whenever you raise the quality and
quantity of your work that becomes the new
standard. As a result, your job enrichment
and personal growth will suffer. Comput-
ers are actually our masters! Feel the welts
from the computer’s whip. “Get back to
work, human slacker!”

The Paperless Office Myth
(Another reprise)
Easy-to-use scanners and e-mail are tools
that are hailed as bringing on the Age of the
Paperless Office. This is a myth because we
generate more paper than ever before.
People like hard copy because it is solid and
tangible and there is satisfaction in holding
a paper copy of your work, We find it
difficult to read a 50-page report or a 5000-
cell spreadsheet on our monitors. We tend
to make multiple copies of our latest report
or presentation so everybody can also enjoy
it. When your manager wants to review
your work, he tacitly wants to see a paper

copy.

Office machines generate more paper.
Printers, fax machines and copiers sell in
record numbers. They all require reams of

often-specialized paper. The OfficeMax
catalog devotes 17 pages to paper products
alone. Internct access also generates more
paper when we print out the information
that we are seeking or are sending that cool
graphics to our ink jet printers.

Thick paper manuals are becoming passe
but “How-Te” books more than make up for
the slight reduction in paper volume. My
manuals take up 12 feet of shelf space and
there are countless stacks of magazines and
paper everywhere, Let's face it, “A
paperless office has about as much chance
as a paperless bathroom!”

The Real Truth Behind the
Computer Revolution
(A Third Reprise)

I started Herb’s Hangout in May 1991 but
before that I submitted my Rules of insanity
that seem often to be true. Let’s start with:
1. Insanity Rules!

2. In case of disbelief, read Rule #1 again
3. Optimistic Insanity: Don’t count on
miracles, rely on them!

4. Pessimistic Insanity #1: A pessimist is
just an informed optimist!

Corollary: By definition, Murphy is an
optimist!

For the Workplace:

1. Boss Insanity: Often wrong but never in
doubt

2. Competency Dilemma: Today’s Incom-
petent could be your boss tomorrow!

3. Best Solution Insanity: The simplest
solution is seldom the chosen one!

4. Job Security Insanity: Never enough time
to do the job right, plenty of time to redo the
job

5. Intelligence vs. Rank: Have you noticed
how intelligence rapidly drops with rank?
6. Use me or abuse me!

Computer Related:

1. it always scems more believable if it is
done on a computer

2. Mass Storage Insanity: No matter how
big your hard drive is, you will run out of
storage space within a year

Coroliary: No matter how much RAM you
have, some fool will create a Killer App that
forces you to buy more RAM

3. Boot Up Dilemma: No matter how fast
and powerful your computer is, it still takes
about a minute to boot up!



' programs. :
- .. processof or spreadsheet for example, if
- the ones-you’ve been using still do
) _.Hleverythmg you require? Save your new

* 'machine for. up-to-date graphics, games or

Networking: Upgrade that
makes sense
Ken Fermoyle

First came “sneaker networking” in the late
*70s, early '80s, when we carried floppy
diskettes from computer to computer. Then
came “poor-boy networking,” using simple
switches, null modem cabies, software like
LapLink and MacLink to share printers and
transfer files. Often we simply plugged and
unplugged cables. Maclntoshes had the
advantage of built-in network capabilities,
although at just 230.4 Kbps transmission
speed was slow.

1 tried all of the above during the 1980s in
my home office and as a partner in a small,
pioneering publishing service bureau. A
“real” network, with servers and client
workstations, was out of reach.

Things have changed! Low prices, simple
" peer-to-peer networks, and support built
into current operating systems now make
it inexpensive and easy to link computers
and peripherals in home or small business
offices. Today you can enjoy the benefits
-of a:true Ethernet network for under $100
- -if you run Windows for Work groups

o3 ]) Wmdows 95,.98 or NT; or Mac OS

(and want more speed than Apple Talk
provndes)

Addmg a simple network is especially
attractive if you are adding a new computer.
Don’t get rid of your old one. You won’t
get much for it, and it can still be a useful
asset. How? - By linking it to the new
‘compitter via a simple network. Consider
these pOSSlbllltles.

' Fn'st _you can keep all your pet programs,
~ especially “legacy” 16-bit Win3x and/or
~ DOS pps, on the older machine and use

- them as you always have. Use only 32 -bit

- software on the new computer to improve

: p rfom:ance

e Second, you can ehmmate duplication of
 Why-invest in a new word

: ,Internet-related programs that really benefit
from better performance. .

Third, you can use each of the two
computers to back up the other one. John
Bowen, honcho of the Black Lake
Computer Club, Nipomo, CA, showed me
some months ago how he and his wife do
just that with their His & Her computers.
It’s probably the easiest way to do backups.

One thought here: If your old computer has
its hard drive(s) filled to bursting , consider
adding another one just for backup use.
New multi-gig hard drives are really cheap
now, and 1 suspect it’s possible to find
decent used 1.2 to 2.5 gigabyte drives for
$25 to $50. (Part 3 of this Upgrades that
Make Sense series will zero in on hard
drives, incidentally.)

All you need to set up a network are the
following:

* A Network Interface Card (NIC) for each
computer and appropriate driver * Thin
coaxial or unshielded twisted pair (UTP)

-cabling in appropriate lengths * BNC

connectors and terminators, if you use
coaxial cables * Multiport hub, optional if
you want to connect more than a handful
of computers, necessary if you want a Fast
Ethemet network (100 Mbps vs 10 Mbps
for standard 10Base-T Ethernet), which is
probably overkill for most of us.

Prices? Very reasonable! I've seen full-

duplex, Plug-and-Play Ethernet cards for -

as littie as $15 to $20; 5-port hubs run from
about $40 to $100. UTP 10Base-T cables
resemble ordinary telephone wire but use
RJ45 connectors and have eight wires
inside. Coaxial 10Base-2 cables look like
those that connect TVs to VCRs, with
similar twist-on BNC connectors. Prices
vary by length, but a 10-footer typically sells
for about $11 to $14 for either type. Use
cables that meet Category 5 standards to
ensure top performance and future
expandability. For networks with more
than a few computers or when using Fast
Ethernet, experts recommend UTP cabling,

To connect just two computers, it’s often
cheaper and easier to buy a kit that includes
two NICs, a 10Base-2 coax cable,
connectors and terminators, driver setup
software and detailed installation
instructions. This is especially true for
novice networkers. With akit, you’re sure
that components match, and you have a
single source to contact should you need

tech support. You can add one or two
computers to this type of network later,
daisy-chaining them with additional NICs
and cables. Use a hub and UTP cables for
bigger networks.

I"ve used the LinkSys (www.linksys.com)
Network in a Box and StarTech Computer
Products  (www.startechcomp.com)
Network Kit {under $100) and they worked
well. Make sure the NICs have both BNC
and RJ45 connectors so you can upgrade
to twisted-pair cables if you decide to add
a hub and expand your network later, !
haven’t tried Netgear’s starter kits (about
$120) that use UTP cables and a 4-port,
externally powered hub, or a similar one
from Linksys (two PCI NICs, S-port hub,
about $95), but both are attractive,
expandable options.

My entry to networking in 1996 came after
buying a new HP inkjet printer designed
for use with bidirectional paratiel ports and
IEEE-1284 cables. We already shared two
printers, using A-B switches, I couldn’t
find a switch that was compatible with the
IEE-1284 standard, and I tried! Installing
a network was the farthest thing from my
mind, until I spotted Network in a Box from
LinkSys. It looked simple enough (though
I had grave misgivings) and the cost (then
about $90, now under $70) was less than
some of the switches I priced.

Physical installation was easy. Pilot error
(I misread a key direction) created a few
problems with the software setup. A little
help from my friends at ASCC computers,
my local computing life support system here
in Woodland Hills, CA, solved that. Life
instantly became much easier. My wife and
1 had easy access to the printers and each
other’s files. If I was working on a
newsletter and needed a graphics file Liz
created, it was a snap to import it from her
computer.

. Pm currently nearing the final stage of a

major system overhaul, including one new
computer as a server, upgrades to three
others, adding another printer, and new
modems. Instead of having just two
computers linked I will have four on the
new net via a 5-port 10Base-T hub and UTP
cables. I'll fill you in on that project in a
future column.



Genealogy SIG
November 4, 1998
Richard Bagnik

Wednesday was the Annual Beginners’
SIG. Stan was able to find a meeting place
asthe OCIPUG Resource Center/SIG space
was vacated 29 October. Unfortunately, this
evening’s site is not available in the future.
The acquisition of a meeting room to hold
future Genealogy SIGs is still up in the air.
When a place becomes available, Stan will
contact everyone on his e-mail list in the
hope that those people will contact others
who may be interested. There is a computer
genealogy meeting at the OCCGS monthly
meeting at the Huntington Beach library.
Chris Hansen, Rod Bush and Stan rotate
as instructors,

Currently, Stan rates Ancestral Quest as the
best genealogical program for most users.
His new second place choice is Legacy.
Legacy’s updates are available for
download from the Internet. Family Tree
Maker is Stan’s third choice, with Family
Origins ranking number four. All are
Windows applications. This evening, Joy
printed out an identical family history file,
“group sheets, and personal histories on
‘three different genealogy programs for us
to compare. Stan feels that a program’s
most important quality is ease of use. His
second criteria concerns a program’s
features, or what it can do, but this value is
ali lost if the program is not easy to use.

Stan opened up his version 2.1 of Ancestral
Quest on the screen. Although a beta of
version 3 is circulating, it’s main feature is
that it is designed to be used with PAF 3.0
databases. If you are not using that
database, version 3 won’t be a great
improvement over 2,1. From the top menu,
if you click Help>About Ancestral Quest,
you will see at the top an exact
identification of the version of Ancestral
Quest that you are using.

The database on the screen was Stan’s own,
so as to show what a filled-out pedigree
chart should lock like. But to show how
an “empty” program looks before any data
is entered, he began the process with an
empty copy of Ancestral Quest. As you fill
in your pedigree screen, Ancestral Quest
will create all the files it needs to handle
your family history, and it will create these

files transparently, that is, without your
belp. Using the File>Open menus at the
top of the screen you create and name a
subdirectory such as “Jones/Smith
Families” and the blank pedigree screen
with “Jones/Smith Families” at the top of
the blank pedigree chart will appear ready
for you to go to work.

Ancestral Quest, from the beginning!! You
would start at the top, clicking the icon with
a person’s head with a + sign. This brings
up the dialog box with which you fill in a
new person. And often when you go to a
new feature you get a “TIPS" screen. You
can discontinue its appearance when you
have learned what it has to say and can get
it back later if you want it. Stan then filled
out a form with his own information. Then
the data goes into the pedigree chart
automatically. A pedigree chart is a way
of seeing individuals' data and their
relationship to other family members such
as their ancestors. When you add a father
the program automatically inserts the
surname (last name}. You may change the
surname of your father if it was different
in the old country or he/she changed for
some other reason. Then after your father,
a marriage form comes up and then the
wife’s.

Then, back to the pedigree chart, there’s a
button for Spouse to produce a spouse’s
form to fill cut. Buttons to add children
are also available from the pedigree screen.

A Family Group Record shows husband and
wife and their kids and most of the
information on everyone. All programs do
this. But after you have your family group
record filled out afier a visit to a relative,
he strongly recommends you enter it into
the computer as soon as possibie, where you
can then make copies in any quantity.
When Stan receives any data on a floppy,
he always runs a virus check on every disk.

There is one Preference that should be
noted. Under Tools> Preferences>General
tab is “Capitalize Surnames.” Click this box
“On.” You will then type all proper nouns
with an initial cap only, but Ancestral Quest
will transform all surnames to FULL CAPS
when displayed and printed. Thus, George
Cleveland will be displayed and printed as
George CLEVELAND, while Cleveland,
Ohio will be entered as initial caps,

preserving the instant identification of ali
surnames as opposed to place names.

Right clicking on the highlighted
individual on the Pedigree screen produces
a menu from which you may choose several
options pertaining to just that individual,
such as Edit, Delete, Notes, Media,
Descendancy, etc.

A question from the floor asked what good
are Unlinked individuals in your database.
Their value is in allowing you to list people
that you are pretty sure are members of your
family but whose link to your known farnily
has not yet been established.

Stan keeps multiple copies of his backups
on a series of floppy disks. Each time he
backs up, it is to a different disk of the five
he keeps. The logic is this. If his current
database is somehow contaminated and he
doesn’t know it, and he dumps it into only
one backup disk, then that disk becomes
contaminated too because, since the file
names are identical, the current
contaminated information overwrites the
old and they both become useless.

Stan has put twelve generations of his
database onto the Internet. He limited its
size to just under 5 MB because His Web
site allows up to 5 MB free. This is a great
way fo publish.



Meeting of the Executive
Board of Directors

Qctober 17, 1998

Pursuant to a determination that a quorum
was present, a special meeting of the
Executive Board of OCIPUG was called to
order by President Wayne Ali at the
Resource Center, 1520 Brookhollow Drive,
suite #38, Santa Ana, California, at 10:12
a.m. :

Officers present;
Wayne Ali

Rob Nelissen Larry Pearce
Directors present:

Jeanne Levan Arlene Solomon
Dennis Walz Bruce Williams
(1 vacant Director position)

Preston Hill, Past President

Absent:-
Don Testa . Sue Hayes
Leonard Robertson Edward Wolf

: :Guests Tony Dopazo, Kevin Moser, Dean
.i'_.50wers, _ :

, .:Approval of Mmutes

The Minutes of the previous meeting
(September 28,1998) were dispensed with
and not read at this meeting:

President’s Report:

President Wayne Ali presented a report on
the serious declining membership of the
club, related financial burdens associated
_ with- the’ declining membership, and the

“ability of the club to sustain the rent for the
" Resource Center at Brookhollow scheduled
to increase an additional $75.00 on
' ‘November 1, 1998. The current

membersh:p levels make it necessary to

..vacate the Resource Center and return the

» prem:ses to the landlord.

Vacatmg the premuses requires plannmg to
‘remove and store the club’s equipment,
furnitire and BBS operation until a new

“Jocation can be found as well as termination
. of telephone services. Prospective locations
are being looked into at this time. In

) 'adcl__ition, ‘Orange Coast College has .

indicated that rent for the Science Hall at
the college for OCIPUG General Meetings
will increase an undetermined amount after
the end of this calendar year.

Attempts to sublease the Resource Center
by Arlene Solomon and Preston Hill, as
provided in our lease, have resuited in only
one inquiry for approximately 400 sq. fi.
of the total leaseable space, Any prospective
tenants for sublease must be confirmed
before the end of the month.

- InterNIC has not notified the President that

InReach e-mail has been transferred and
may now be in jeopardy because of the need
to vacate the Resource Center and
termination of telephone service.

Several key positions need to be filled in
the club, including Readme.Doc¢ Editor,
SYSOP, Program Committee Chairman,
and auctioneer for the auction at the
General Meeting on Saturday, October
31,1998,

Financial Report:

Treasurer Larry Pearce confirmed the
membership renewals were at an all-time

-low. Cash on hand in the operating account

is $789 with Resource Center rent now due
and payable in the amount of $1265.22 plus
triple net expenses. Printing costs for two
issues of the Readme.Doc totaling

_ approximately $1700.00 are unpaid. Other

current expenses for the month of October
have not been paid due to limited cash flow.

Business:

Vacate Resource Center: It was moved
(Hill) and seconded (Walz) to vacate the
Resource Center at 1520 Brookhollow
Drive, #38. Santa Ana, California no later
than October 31, 1998 due to deciining
membership renewals and limited cash
flow. Motion carried.

Action authorized: Dean Sowers and Kevin
Moser are to assist in the preparation of a
revised message for the club’s hot line
telephone answering machine for Reg
Roberts. Rob Nelissen and Jeanne Levan
are to begin moving some computers and

equipment on Wednesday, October

21,1998, Kevin Moser is to investigate
temporary storage of OCIPUG property.

Tony Dopazo is to contact Richard Black
to folow-up with Michael Moore regarding
InReach Web page activation status,
Preston Hill is designated coordinator for
the move and vacating the Resource Center.
Ed Miller is to act as auctioneer for the club
auction on Saturday, October 31,1998
General Meeting,

Terminate Telephone Service: It was
moved(Hill) and seconded (Levan) to
authorize Treasurer Larry Pearce to
terminate the telephone service on or before
COctober 31, 1998 as appropriate to vacating
the Resource Center. Motion carried.

Adjoumment: The meeting was adjourned
at 12:07 p.m. The next meeting of the
Executive Board of Directors will be
Monday, October 26,1998 at the Resource
Center beginning at 7:00 p.m,

Respectfully submitted

Rob Nelissen, Secretary



Meeting of the Executive
Board of Directors
October 20, 1998

Pursuant to a determination that a quorum
was present, a regular meeting of the
Executive Board of OCIPUG was called to
order by Secretary Rob Nelissen at the
Resource Center, 1520 Brookhellow Drive,
suite #38, Santa Ana, California, at 7:07
p.m.

Officers present

Rob Nelissen Larry Pearce

Directors present

Jeanne Levan Leonard Robertson

Arlene Solomon Dennis Walz

Bruce Williams Edward Wolf

(1 vacant Director position)

Preston Hill, Past President

Absent :Wayne Ali
Don Testa

Sue Hayes

Guests:
Tony Dopazo, Kevin Moser, Max Lockie
John Lunsford, Reg Roberts

Approval of Minutes:

The minutes of the previous meeting
(September 28,1998) were approved as
recorded and submitted. The Minutes of the
Special meeting of the Board of Directors
(October 17,1998) were approved as
recorded and submitted.

President’s Report:

Chief Financial Officer Larry Pearce
distributed copies of the President’s
message in response to member Ed
Leckliters’s e-mail regarding vacating the
Resource Center, copies of the letter from
the Brookhollow Leasing office demanding
payment of rent and $1023.33 in additional
triple net expenses from the prior year, and
three-day Notices by the landiord to pay or
quit as posted on the premises.

Secretary’s Report:

Secretary Rob Nelissen reported on

correspondence, auction items and member

renewals received during the month, with

member renewals continuing to show
significant declines.

Move Repott:
Past President Preston hill reported
vacating the Resource Center is nearly

complete. The BBS has been shut down and
most of the equipment and furniture
removed from the premises. A dBASE SIG
meeting will take place on Wednesday
evening, and Thursday all remaining items
will be removed, telephones turned off and
keys will be delivered to the Leasing office
finalizing voluntary surrender of the
premises. Temporary storage space has
been rented to receive most of the furniture
and other items removed from the Resource
Center, sensitive computer and projection
equipment is temmporarily stored at the home
of Preston Hill.

Financial Report:

Chief Financial Officer Larry Pearce
reviewed the financiat report for the month
of September, and preliminary data for the
month of October, 1998. No bills have been
paid in October because declining member
renewdls and other receipts produced
insufficient cash-flow to pay all bills
currently due and payable.

A membership report completed on October
24% was also reviewed reflecting a paid
membership of 380 members, down 115
members from December 1997 (10
months). In addition, communication has
been received from Orange Coast College
reflecting meeting room and equipment
rental rates for 1999 representing a
substantial increase over current 1998
rental rates with a minimum of 50%
increase in rent for the same facilities
currently being used for OCIPUG’s General
Meetings. Summary reports were
distributed to the Board of Directors.

Auction Report:

Rob Nelissen and Preston Hill reported that
approximately 58 items have been delivered
to Chris Lloyd for the Saturday fund-raising
auction, with an additional 6 items added
today. Richard Black and Ed Miller will
serve as auctioneers with various members
identified as assisting in the tasks to be
done.

Business:

Payment of Bills: It was moved (Hill) and
seconded (Wolf) the following bills be
authorized for payment before the end of
the current month, subject to receipt of
sufficient funds during the month;

Science Hall Rent (Orange Coast College)
$200.00
Print masters (September printing -
Readme.doc)
89.55
West Coast Internet (October e-mail)
25.00
State of Calif. Statement of domestic Siock
10.00
Pacific Bell (October telephones)
130.00
U.S. Postmaster (Nov./Dec. Readme.doc
mailing)
70.00

Motion carried (Unanimous)

December General Meeting: It was
moved (Wolf) and seconded (Walz) that in
consideration for the limited numbers
attending the General Meeting in
December, the December General meeting
is canceled, and any presentations currently
scheduled for December be rescheduled to
a meeting in 1999,

Motion carried (unanimous)

Orange Coast College General Meeting
Facility:It was moved (Williams) and
seconded {(Wolf) to terminate use of the
Science Hall at Orange Coast College for
OCIPUG General meeting due to the
declining members attending and increased
cost of the facility beginning in
January,1999, and to negotiate with the
college to rent the Fine Arts building #116
with & capacity of 125 on a month-to-month
basis at the rental rate of $188.00 per month
beginning in January, 1999. Motion carried
{unanimous). Additional efforts will
continue to locate other facilities.

Adjournment:
The meeting was adjourned at 10:07 p.m.
The next regular meeting of the Executive
Board of Directors will be held at 7:00 p.m.
Monday, November 30, 1998 at a new
meeting place to be announced.
Respectfully submitted
Rob Nelissen, Secretary



PRODUCTS FOR REVIEW
Nerm Berpman

The products listed below have been received by OCIPUG for evaluation by qualified members. Contact the
Editor if you want to evaluate any of these products. Also, please let the Editor know of any products that you
think we should review and the Editor will try to get them. The reviewer should recognize the wide range of
interests of club members and, if the product does not coincide with the reviewer’s own interests, promptly
return the product to the Editor for reassignment. The review becomes the property of OCIPUG and may be
edited and reproduced by the product donor and other user groups. The reviewer’s name will be used as author
of the article. Upon submitting a satisfactory review article to the Editor, the registration materials and product
will become the member’s personal property. A balanced evaluation should point out the product’s good points
as well as its shortcomings. The reviewer agrees to observe OCIPUG’s rules and will not share software or other
products with others. The reviewer will be given a copy of Guidelines for Product Reviews to assist in preparing
the report. If the reviewer will be unable to complete a review as scheduled and agreed, the materials must be
returned to the Editor or any OCIPUG officer or director, or other arrangements made with the Editor. Returned
product will become available for review by others.

Be sure to ask about the computer requirements for the software. Most of these require a CD-ROM drive
and some require Win95 or later, or 32bit systems.

“_-'I._i _ McAfee WebScanX Protects against viruses from the Internet.

2. Viewpoint: LiveArt. Digital object library that you can resize, relight, spin around, draw in familiar artistic
styles.

_ 3. MGI Software: MGI VideoWave 4.0 Capture vudeo and images, do special effects, add narration and
_sound effecis ,

. 4 PowerQuest Power Tools (Two copies availoble.) Thirly-day trial of PartitionMagic, Drive Image and
-"DnveCopy

-3 7_7:G|0b0|ink': Language Assistant translates French, German and ltalian text to/from English.
6. -Miienix: Zip Mc_lgiuc98 Use zip files without unzipping, save disk space web and e-mail features.

7. '”Ml|en|x: PowerDesk Utilities98 An alternative desktop to Win95. Move, copy, zip and view files and many
oiher u‘hllhes

-8, Caere Pugel(eeper (Standard) Orgunlze and find scanned and electronic documaents in your computer.

9. ._ Jasc:_ Paint sint Shop Pro 5 Easy image und pholo editing for presentation abd Web graphics




OCIPUG SUPPORT

The members listed below have generousty offered
to serve as resources for other members in need of
assistance with specific hardware or software
problems. They are there for you, but please bear a

few things in mind:

The times fisted are when these volunteers are avatlable
1o assist you. Please respect their times by limiting your
calls to the hours indicated.

Your questions should be specific and reasonably brief.
Consuit your manual, tech support, etc., first, so as not
to take up their time needlessly.

All of our volunteers have expertise in the areas shown,
but nobody knows everything, so be understanding by
not expecting them to know everything.

This service is free, available to our members only. Qur
volunteers are not doing this for personal gain, but as a
service 1o benefit their fellow PC users, thereby making
OCIPUG astronger organization,

Abraxas
Kevin Post — anytime........ccocvnnins 969-9495

AccPac Simple Accounting
Ron Collins — 6-10 p.m. M-F
Wkends after 9 a.m......493-6520
Chnstlan Malm — 9 am.-9 p.m. M-F
Anytime Wkends........ 966-5339

Ami Professional
Stan Sabin — 5 p.m.-9 p.m. M-F......968-7307
Richard Sinor — 6 p.m.-10 p.m........ 951-1892

Approach
Maurie Seymour-9 a.m.-9 p.m.M-F.....633-2914

BBS ( Bulletin Board Service)

Preston Hill - 9 a.m.—-9 p.m...cvceeeee.. 893-2403
Dean Sowers 10 a.m.-9 p.m. .............. 531-0477
BASIC

Herb Huey — 6 p.m.-10 p.m............. 525-1608
Borland Delphi

Maurie Seymour — 9a.m.-9p.m......... 633-2914

Champion Business Systems
Kevin Post — Anytime........oininrens 969-9495

Clipper

Bob Wendorf—Anytime.....................892-1031

Corel's Ventura

John Goodman — 2 p.m-12 mid.......... 537-6400
(Preferred);johni@agoodman.com

dBase IV

Preston Hill-— 9 am.-9p.m...ccvrcren 893-2403

Digital Photography and Scanning

Ken Martin—8 a.m.-11p.m. except Sunday
..637-5577

Rex Sufton—9 a.m.-10 p.m........... 949-786-5862

dBase Programming
Tom Toner — 10 am.-8 pm............... 537-9175

Disk & Memory Management
John Goodman — 2 p.m.-12 mid........537-6400

{Preferred):. john@agoodman.com
Bill Krehbiel — 24hrs daily................ 645-8561

DOS

Herb Huey — 6:00 p.m.-10 p.m.......525-1608

John Goodman —-2 p.m.~ 12 mid........ 537-6400
(Preferred):.. john@agoodman.com

Bill Krehbiel — 24hrs daily................645-8561
Excel

Herb Huey — 6:30 p.m.-10 p.m.......525-1608
Fortran

Herb Huey — 6 p.m.-10 p.amn............ 525-1608
FoxPro

Stan Hetrick — 6 p.m.-10 p.m. M-F
Anytime Wkends....... 774-3115

Genealogy
Stan Sabin— 5 p.m.-9p.m. M-F._....... 968-7307
Preston Hill— 2 am.-9 p.m............ 893-2403
Hardware

John Goodman — 2 p.m.-12 mid......537-6400
(Preferred)....john@agoodman.com
Bill Krehbiel — 24hrs daily...... e 645-8561

Internet
Richard Armenteros—o6pm.-11pm....378-9311

MAS 90

Christian Malm — 9 a.m.-9 pm. M-F .......
Anytime Wkends.......966-5339

Microsoft Werd
John Goodman — 2 p.m.-12 mid........ 537-6400
(Preferred):...john@agoodman.com

Microsoft Works

Bill Krehbiel — 24hrs daily................ 645-8561
PC Tools

Preston Hill — 9a.m.-9 paiinininns 893-2403
PageMaker

Preston Hill —9a.m.-9 pmnvcevcnreccrnns 893-2403

Paradox DOS/Windows
Jim Samuelson — 6 p.m.-10 p.m.....472-9822

PerForm
Richard Sinor--6 p.m-10 p.m.M-F ..., .951-1892

QModem/ProCemm

Bill Krehbiel — 24hrs daily............... 645-8561
Quattro Pro

Preston Hill — % am.-9 pm............ 893-2403
QuickBooks for Windows

Cathy Hall — Anytime ................... 434-7307
Max Lockie—6 p.m.-9 p.m. .............. 720 -8 170
Quicken

Preston Hill — 9 am.-9 p.m............. 893-2403

Ron Ross ~ 6 p.m.~10 p.m. M-F
Anytime Wkends ....... 964-5137

Quickpay
Ron Ross — 6 p.m.-10 p.m. M-F
Anytime Wkends........ 864-5137

Real Estate Software

Stan Sabin — 5 p.m.-9 p.m. M-F..... 968-7307

Stacker
John Goodman — 2 p.m.- 12 mid........ 537-6400
(Preferred).... john@agoodman.com

Bill Krehbiel — 24hrs daily........c.c..... 645-8561
Visual dBASE

Max Lockie— 6 p.m.-9 p.m................ 720-8170
Windows 3.x and 95

Richard Hunter—9a.m.9p.m.M-5a ......968-6362
Bitl Krehbiel — 24hrs daily.....cocveein 645-8561
Bilt Phillips—9 &a.m.-9 p.m.................281-8171
WordPerfect

Preston Hill— 9 am.-9 pm....oveeen. 893-2403
Richard Baznik—9 a.m.-6p.m............ 669-8974

Note: If you would like to be listed here as
a volunteer to help with any PC-related
subject, please call Preston Hill (714) 893-
2403 or leave a message on the BBS. We
need volunteers in many more software and
hardware areas. The success of this
program depends on your help.



People and numbers to know
(All may also be reached directly on the BBS or via Internet email at *(First Name).(Last Name)@ocipug.org”

BBS 714-892-1291 Information Hotiine 714-662-2939

Executive Board

President Wayne Ali 714-972-4695 wk.ali@prodigy.net
Vice President Don Testa 714-840-5300 dtesta@pol.net
Secrerary Rob Nelissen 714-281-0234 tkboo@worldnet.att.net
Treasurer Larry Pearce 714-5435661 larry.pearce@junc.com
Director-2000 Sue Hayes 714-373-6931 suzy724@aol.com
Director-2000 Jeanne Levan 714-545-6740 jeanlavan@aol.com
Director-1999 Leonard Rebertson 949.855-3030 ayamari@pacbell.net
Director-1999 Arlene Solomon 714-891-388% lowtax@worldnet.att.com
Director-2000 Dennis Walz 714-545-1762 dawalz@worldnet.att.net
Director-2000 Bruce Williams 714-744-4951 -
Director-1999 C. Edward Woife 949-646-5608 ewolfe5296@aot.com
: Committees
Advertising Bruce Williams 714-744-495} -
BBS . Ed Milier 949-470-9319 edmiller@ix.netcom.com
Calendar Specialist Maurie Seymour 714-633-2914 mauries@pacbell.net
Community Outreach Arlene Solomon 714-891-3889 lowtax@worldnet.att.com
Library : Bob Blakeley 714-549-0958 blakeley@inreach.com
Long Range Planning Tony Dopazo 714-897-3912 tdopazo@ix.netcom.com
Marketing . Bruce Williams 714-744-4951
Membership Accounnng Ken Pacth 714544-5158 kenpaeth@bigfoot.com
Newsiétter Editor Preston Hill 714-893-2403 prestonlh@bigfoot.com
Newsletter Distrib. Michael Conway 714-962-2194 -
Newsletter Layout Charles Schreiber 713-377-0439 cschreib@csulb.edu
‘Policies & Procedures Kevin Moser 949-631-2966 -
- Programs = Preston Hill 714-893-2403 prestonlh@bigfoot.com
“Property Ed Wolfe 949-646-5608 cwolfe5296(@aol.com
. 8IG Coordinator "Biil ‘Splitter 714-846-5652 bsplitt@ix.netcom.com
Rules & Bylaws Ed Miller . 949-470-9319 edmiller@ix.netcom.com
‘SYSOP - - Dean Sowers 714-531-0477 dean.sowers@juno.com
‘Webmaster Michael Moore 714-535-0608 mmoore@inreach.com
ST Special Interest Groups (SIGs)
3D Studio John Hostick 714-731-8873 jhost@pacbell.net
dASE Max Lockie 949-720-8170 miockie@ix.netcom.com
dASE . ¢ Tom Toner 714-37-9175 -
Digital Photo/Scan _ Rex Sutton 949-786-5862 rexss@aol.com
‘Gepealogy Stan Sabin 714-968-7307 stansabin@usa.net
Genealogy 11 Chris Hansen 714-637-01062 cphansen{@aol.com
Internet- . . Michael Moore 714-535-0608 mmoore@inreach.com
Internet Day -Frank Disparte 714-960-7494 fidisparte@pobox.com
Investing : “Mel Mellini 714-536-8733 vvmel@gte.net
- Microsoft Office Ken Kamber 714-637-4496 kkamber@bigfoot.com
. Microsoft Office Louise McCain 714-434-0784 swpgimom{@aol.com
- Microsoft Oﬂice Alan Liebschutz 949-859-5815 amliebschutz@ibm.net
- Modem. . Kim Kymlicka 949-495-1319 kymlicka@vmicro.com
‘Modem i : David Yap 714-847-1517 kh6ban@ix.netcom.com
-New User - . John Lunsford 714-995.0947 jlunsford@gentech.com
. 'Now What? - -~ " John Donan 714-633-6616 jfdonan@pacbell.com
_Now What? .- John Goodman 714-537-6400 john@agoodman.com
‘082~ . Steve Schiffman 714-531-0376 schiffman@ibnt.net
03/2 .+ Gary, Granat_ 714-731-0457 ggranat@ibm.net
] -~ Max Lockie 949.720-8170 mlockie@ix.netcom.com
< Ed Miller 949-470-9319 edmiller@ix.netcom.com
" Frank Disparte - 714-960-7494 fldisparte@pobox.com
Richard Hunter 714-968-6362 rihunter@bigfoot.com
Rudy Wolf 714-528-3715 rudywolf@pobox.com
- Jeff Sion 714-775-2390 jsinn@bigfoot.com
‘Richard Baznik 714-669-8974 rbazniki@homes.com
" George Austin 310-375-7213 dbjh85a@prodigy.com



